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Parallels Desktop for Mac lets you seamlessly run Windows and Mac OS X side-by-side, drag-
and-drop your files between operating systems, and run Windows software on your Apple 
computer without rebooting. This chapter provides general information about Parallels Desktop 
for Mac and this User Guide. 

In This Chapter 
About Parallels Desktop........................................................................................................ 5 
Getting Help .......................................................................................................................... 6 
Feedback ............................................................................................................................... 6 
Key Terms............................................................................................................................. 7 
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About Parallels Desktop 
Parallels Desktop® is a virtualization solution that allows you to create virtual machines on 
Macintosh computers with Intel® processors (1.66 GHz and faster). You can install a Windows, 
Linux, Mac OS X, or any other supported guest operating system in each of your virtual 
machines, and work with them and their applications side by side with your Mac OS X 
applications. 

 

Built on Parallels’ award-winning hypervisor-based virtualization technology, Parallels Desktop 
allows you to: 

 create powerful and easy to use virtual machines 
 use 32-bit and 64-bit operating systems inside your virtual machines 
 use Windows and Linux applications side by side with your Mac OS X applications, without 

restarting your Mac 
 concurrently work with the files and applications from your Mac and your virtual machine 
 create Parallels virtual machines from physical computers and third-party virtual machines 

To enhance your experience of running more than one operating system on your Macintosh 
computer, Parallels Desktop for Mac includes Parallels Transporter® for transferring data from 
physical computers to Parallels virtual machines and Parallels Mounter for accessing your 
virtual machine's files and folders even when it is not running. 
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Getting Help 
Parallels Desktop provides several ways to access the necessary information: 

 Search Field. You can use this field available from the Parallels Desktop Help menu to 
perform a keyword search in both Parallels Desktop Help and the Knowledge Base. In this 
field, type a keyword and click Show All Help Topics - the related topics will be displayed. 

 Parallels Desktop Help. Contains extensive information about the product and its uses. To 
open Parallels Desktop Help, choose Help > Parallels Desktop Help from the menu. 

 Help Buttons. In most windows, you will find a help button  opening the corresponding 
help page. 

 Online Documentation. PDF documentation for Parallels Desktop and Parallels Transporter. 
To open the online documentation page, choose Online Documentation from the Help menu. 

 Parallels Command Line Reference Guide. This guide contains information on how to use the 
prlctl command line utility designed to manage Parallels Desktop and its virtual 
machines from Terminal. To access the guide, go to the Online Documentation page on our 
website. 

 Parallels API References and the SDK Programmer's Guide. These guides are written 
primarily for IT-professionals and can be found on the Online Documentation page on our 
website. 

 Parallels website (http://www.parallels.com). Explore the Support web page that includes 
product help files and the FAQ section. 

 Parallels Knowledge Base (http://kb.parallels.com/). This online resource provides 
troubleshooting for common problems and includes helpful articles about using Parallels 
Desktop and other Parallels products. 

 

Feedback 
If you spot a typo in this guide, or if you have an opinion about how to make this guide more 
helpful, you can share your comments and suggestions with us by completing the 
Documentation Feedback form on our website (http://www.parallels.com/en/support/usersdoc/). 

 

 
 

http://www.parallels.com/
http://kb.parallels.com/
http://www.parallels.com/en/support/usersdoc/
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Key Terms 
Guest Operating System (Guest OS). An operating system installed inside your virtual machine. 
It can be Windows, Linux, Mac OS X, or any other supported operating system. 

Primary Operating System (Primary OS). The operating system that is loaded when you turn on 
your Mac – Mac OS X. 

Virtual Machine (VM). A computer emulated inside your Mac. A virtual machine has its own 
virtual hardware and requires an operating system. The installed operating system and its 
applications are isolated within the virtual machine and share physical hardware resources with 
your Mac. 
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The installation and upgrade procedures are almost the same. The only difference is when you 
upgrade to Parallels Desktop 6, the installer removes the previous version of Parallels Desktop 
from your Mac. 

In This Chapter 
System Requirements............................................................................................................ 9 
Installing Parallels Desktop................................................................................................... 10 
Upgrading to Parallels Desktop 6.......................................................................................... 13 
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Installing and Upgrading Parallels 
Desktop 
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System Requirements 
Parallels Desktop can be installed on any Intel-based Mac that complies with the requirements 
listed here. 

Hardware Requirements 
 Any Macintosh computer with an Intel processor (1.66 GHz or greater). To run 64-bit 

operating systems in virtual machines an Intel Core 2 or later processor is required. 
 Minimum 1 GB of memory. However, 2 GB of memory is recommended. 

Note: Your Mac must have enough memory to run Mac OS X and your Mac applications, 
plus the memory required for the virtual machine guest operating system and the 
applications installed in it. 

 At least 500 MB of disk space on the boot volume (Macintosh HD) for Parallels Desktop 
installation. 

 15 GB of disk space for each virtual machine. 

Software Requirements 
 Mac OS X Snow Leopard 10.6.3 or later 
 Mac OS X Leopard 10.5.8 Leopard or later 

To get information about your Mac OS X version, type of processor and amount of memory, 
choose About This Mac from the Apple menu. 

Additional Requirements 

You will need the installation media for the operating systems you wish to install in your virtual 
machines. 
 



 

 Installing and Upgrading Parallels Desktop 10 
 

Installing Parallels Desktop 
Before installing Parallels Desktop make sure that your computer meets the hardware and 
software requirements. 

If you purchased Parallels Desktop from the Parallels online store, download the latest build 
from Parallels Download Center (http://www.parallels.com/download/). When the download is 
complete, open the Parallels Desktop DMG package file. To start the installation, double-click 
Install. 

If you purchased a boxed copy of Parallels Desktop, insert the Parallels Desktop installation disk 
into the optical drive of your Mac. Open the Parallels Desktop DMG package and double-click 
Install. 

1 Parallels Desktop will connect to the Parallels update server and check for available updates. 
If there is a newer version of Parallels Desktop available, you will be given the option to 
install the most recent version of Parallels Desktop. If you do not want to install the most 
recent version, you can choose to install the version from the installation media. 

 

http://www.parallels.com/download/
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 If you click Install current, Parallels Desktop will be installed from the installation 
media. 

 If you click Download and install new version, the latest version of Parallels Desktop will 
be downloaded and installed on your Mac. 

If there is no update available or your Mac is not connected to the internet, Parallels Desktop 
will be installed from the current installation source. 

2 In the Welcome window, click Continue. 

3 In the Important Information window, read the product Read Me file. Click Print to print the 
document or Save to save it for future reading. When finished, click Continue. 

 

Note: You can return to the previous steps by clicking the Go Back button. 

4 In the Software License Agreement window, carefully read the license agreement. We 
recommend to print the license agreement for your records using the Print button or to save 
it for future reading using the Save button. When you are ready, click Continue. 
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In the pop-up dialog, click Agree if you agree with the terms and conditions of the license 
agreement. 

5 In the Customer Experience Program window, read about the Parallels Customer Experience 
Program and click Continue. 

In the pop-up dialog, click Yes if you want to participate in the program. If you don't want to 
participate, click No. 

Note: If you choose not to participate, you may join the program later using the Advanced 
pane of Parallels Desktop Preferences. 

6 In the Select a Destination window, select the hard disk you would like to install Parallels 
Desktop. You can install Parallels Desktop only on the boot volume, that is the hard disk 
where Mac OS X is installed. Other disks, if any, will be unavailable for selection. Click 
Continue. 

Note: If you have only one volume on your Mac, this step is omitted. 

7 Click Install to start the Parallels Desktop installation. 

8 Enter your password when prompted and click OK. 

9 The installation progress is shown in the Installing Parallels Desktop window. 

10 The Installer informs you that the installation was successful. To complete the installation, 
click Close. 

After the installation, you can launch Parallels Desktop from the Applications folder on your 
Mac. 
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Upgrading to Parallels Desktop 6 
To upgrade Parallels Desktop 3, 4 or 5 to version 6, you will need to purchase an upgrade from 
the Parallels Online Store (http://www.parallels.com/buyonline). The upgrade activation key 
will be sent immediately to the e-mail address you provided. 

Note: Parallels Desktop 2 cannot be upgraded to Parallels Desktop 6. 

You can upgrade Parallels Desktop 3, 4 or 5 to any language version of Parallels Desktop 6. 
This means, if you have an English version of Parallels Desktop 4 and want to upgrade it to a 
German version of Parallels Desktop 6, you can simply purchase the German upgrade, install it 
on your Mac, and activate it with the upgrade activation key. 

Before the upgrade, you must shut down any virtual machines running on your Mac and quit 
Parallels Desktop. 

The upgrade takes three steps: 1) installing Parallels Desktop 6, 2) activating it using the 
upgrade key, 3) and upgrading your virtual machines. 

Installing Parallels Desktop 6 

Generally, the upgrading procedure for Parallels Desktop is the same as for its installation. See 
Installing Parallels Desktop (p. 10). 

You don't have to remove the previous version of Parallels Desktop before installing the 
upgrade: it will be removed automatically during the installation. 

Using an Upgrade Activation Key 

When you open Parallels Desktop 6 for the first time, you will be prompted to activate your 
copy. 

If your previous version was activated using a full key, not a trial one, you will need to provide 
the upgrade key only. Otherwise you may be prompted to confirm that you have a valid full key 
for the previous version: 

 If you activated Parallels Desktop with a trial activation key, you will be prompted to enter 
two keys: the upgrade activation key for Parallels Desktop 6 and a full or upgrade key for 
the previous version. 

 If you purchased the previous version of Parallels Desktop but haven't installed it on your 
Mac, you will need two keys to activate Parallels Desktop 6: the upgrade activation key for 
Parallels Desktop 6 and a full or upgrade key for the previous version. 

Upgrading the Virtual Machine Configuration and Updating Parallels Tools 

When you start a virtual machine created in the previous version, the upgrading procedure starts 
and runs automatically. During the upgrade, the virtual machine configuration and Parallels 
Tools are processed. The virtual machine can be used in Parallels Desktop 6 only after it is 
upgraded. 

http://www.parallels.com/buyonline
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Note: In Linux virtual machines, X Server may fail to start after the upgrade, which means that 
you may need to upgrade Parallels Tools manually in text mode. 

If you encounter any problems during the upgrade, visit the upgrade troubleshooting page or use 
the online Troubleshooting guide available through Help > Troubleshooting Guide. 
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To start Parallels Desktop, open the Applications folder in Finder and double-click Parallels 
Desktop. 

 

When you start Parallels Desktop, its icon will appear in the Dock. 

To add the Parallels Desktop icon to the Dock, do one of the following: 

 If Parallels Desktop is currently open, right-click its icon in the Dock and choose Keep in 
Dock from the shortcut menu. 

 Open the Applications folder in Finder and drag the Parallels Desktop icon to the Dock. 

When you open the program for the first time, you will see the Welcome window (p. 16) that 
will help you start working in Parallels Desktop. 

In This Chapter 
The Welcome Window ......................................................................................................... 16 
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The Welcome Window 
The Welcome window provides you with a fast access to the most common Parallels Desktop 
dialogs and assistants. 

If you want to start working with the virtual machines already registered in Parallels Desktop, 
click Use your Virtual Machines. 

Note: Later on, if you do not want to see the Welcome window again, just clear the Show at 
startup check-box at the left bottom corner of the window. 

 

From the Welcome window, you can navigate between the following options: 

 New Windows Installation. This option allows you to launch New Virtual Machine Assistant 
to create a virtual machine with a Windows, Linux, or Mac OS X operating system. 

 Migrate Windows from PC. This option allows you to transfer the whole of a physical 
Windows or Linux computer to a Parallels virtual machine running on your Mac. The source 
computer data will be transferred using Parallels Transporter. To learn more about this 
utility, refer to Parallels Transporter User's Guide. 

 Use your Virtual Machines. If you have any virtual machines registered in Parallels Desktop, 
this option opens the Parallels Virtual Machines list (p. 27) with these virtual machines. If you 
have no virtual machines registered in Parallels Desktop, this option launches New Virtual 
Machine Assistant. 

You can open and view the Parallels Desktop brief tutorials on the Parallels website by clicking 
the Watch Video Tutorials button. 
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To fully run Parallels Desktop, you should activate it with an activation key. If you purchased a 
boxed version of the program, you can find the activation key printed on the installation CD 
sleeve. If you purchased the program online, the activation key was sent to you by email. If you 
downloaded a copy of Parallels Desktop to evaluate it before buying, you can get a trial 
activation key valid for a certain period of time. 

After you activate your copy of Parallels Desktop, you can run virtual machines, install 
operating systems and various applications in them. 

If you upgraded Parallels Desktop to version 6 from the previous version, you need an upgrade 
activation key to activate Parallels Desktop 6. For detailed information, see the Upgrading to 
Parallels Desktop 6 (p. 13) section of Parallels Desktop User's Guide. 

Activating Your Copy of Parallels Desktop 

To activate Parallels Desktop: 

1 Choose Activate Product from the Parallels Desktop menu. 

2 In the activation dialog, type your product activation key into the Activation Key field and 
click Activate to activate your copy. 

 

Now that your copy of Parallels Desktop is active, you need to register it. 
 

Activating Parallels Desktop 
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Trial Activation 
To get a trial activation key for Parallels Desktop: 

1 Choose Activate Product from the Parallels Desktop menu. 

2 In the activation dialog (p. 17), click Get Trial. 
3 Specify your name and e-mail address. 

4 Click the Get Trial button to send this information to Parallels. 

A free trial activation key will be sent to the e-mail address you provided. 

When your free trial activation key expires, you will need to get a permanent activation key. 

Getting a Permanent Activation Key 

To purchase an activation key: 

1 Choose Activate Product from the Parallels Desktop menu. 

2 In the activation dialog (p. 17), click Buy Now to open Parallels Online Store 
(http://www.parallels.com/buyonline) where you can purchase an activation key. 

 

http://www.parallels.com/buyonline
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Parallels Desktop provides several ways of adding virtual machines: you can create a new 
virtual machine, register the virtual machine you used in the previous version of Parallels 
Desktop or import a VMware, Microsoft Virtual PC, or VirtualBox virtual machine. 

Before you can run an added virtual machine you should activate Parallels Desktop. 

In This Chapter 
Creating a New Virtual Machine .......................................................................................... 20 
Opening and Importing Virtual Machines ............................................................................ 23 
Installing and Updating Parallels Tools ................................................................................ 25 
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Creating a New Virtual Machine 
If you have no virtual machines, you can start your work in Parallels Desktop by creating a new 
virtual machine using New Virtual Machine Assistant. 

To create a new virtual machine: 

1 Open Parallels Desktop and click New Windows Installation in the Welcome window (p. 16) 
or the Add button  in the Parallels Virtual Machines list (p. 27), or choose New from the 
File menu. 

2 Insert the operating system installation disc or connect the installation source to your Mac.In 
the Create New Virtual Machine window specify the source of the installation files and click 
Continue. 

You can create a virtual machine using 

 an operating system installation CD or DVD disc 

 an image of such an installation disc 

 or a Boot Camp partition 

If you want to specify the installation source later choose Continue without disc. 
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3 Your operating system will either be detected automatically, or you will be asked to select it 
manually from the list. 

4 If you are going to create a Windows or Linux virtual machine, you may be offered to use 
Express Installation, which is available for most of the popular Windows and Linux 
operating systems. 

In the Express Mode, the operating system and Parallels Tools are installed automatically, 
with no interaction needed. 

To use Express Installation, you will need to provide: 

 for Windows: the Windows product key, a user name and password. 

 for Linux: a user name and password. 

5 If you are installing one of the recent Windows systems (starting from Windows 2000), you 
will need to choose the level of integration between your Windows and Mac OS applications 
and files. You can choose one of the following ways of working with your Windows 
applications: 

 Like a Mac: You will be able to work in both Windows and Mac applications on the 
single Mac OS Desktop, and your Mac desktop, as well as the documents, pictures, 
music, videos and downloads folders will be shared with Windows. 

 Like a PC: your Windows will run in a separate window and your Mac files will not be 
shared with Windows, but you will be able to drag and drop files between the systems, 
as well as copy text. 
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6 Before your start, review your virtual machine name and location. 

If you want other users of your Mac to access your virtual machine, choose Share with other 
users of this Mac - and your virtual machine will be saved in the /Users/Shared folder that is 
accessible to all users. 

If you want to edit your virtual machine hardware configuration before proceeding to 
operating system installation, select Customize settings before installation. 

 
7 When finished, click Create. 

8 The assistant will create a virtual machine based on your settings and install the operating 
system and Parallels Tools in it or if you chose to customize the settings before installation, 
the assistant will open the virtual machine configuration dialog. 

Note: Parallels Tools are installed automatically in most of the popular Windows and Linux 
operating systems. In other operating systems they should be installed manually (p. 25). 

The newly created virtual machine will be accessible through the Parallels Virtual Machines list 
(p. 27) that allows you to easily manage your virtual machines. 

When creating a Windows virtual machine, Parallels Desktop creates an administrator account 
with a blank password. When the guest OS installation is complete, it is recommended that you 
change this password. 
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Opening and Importing Virtual 
Machines 

Parallels Desktop enables you to work with your virtual machines created in Parallels Desktop 
and other virtualization products, including VMware Fusion, Microsoft Virtual PC, and 
VirtualBox. All you need is to convert them to Parallels Desktop 6 format. The conversion is 
performed when you add these virtual machines to Parallels Desktop. 

To add a virtual machine that already exists on your Mac: 

1 Click Open in the File menu, or click the down arrow button  at the lower left corner of 
the Parallels Virtual Machines list (p. 27) and choose Open from the menu. 
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2 In the Finder window locate the virtual machine bundle or configuration file, select it, and 
then click Open. 

 Parallels Desktop virtual machine bundle has the .pvm extension. 

 Parallels Desktop 3 and earlier configuration file has the .pvs extension. 

 VMware configuration file has the .vmx extension. 

 Virtual PC configuration file has the .vmc extension. 

 VirtualBox configuration file has the .xml extension. 

Note: Parallels Desktop and VMware Fusion virtual machines may be stored in Mac OS X 
as bundles of files. The configuration file is stored inside the virtual machine bundle. 

3 The next step depends on the virtual machine you selected: 

 If you selected a virtual machine created in Parallels Desktop 4, 5 or 6, its window will 
open. When you start this virtual machine, Parallels Desktop will ask you to update 
Parallels Tools.  

 If you selected a virtual machine created in Parallels Desktop 3 or earlier, its window 
will open, and Parallels Desktop will offer you to convert it to the new format. This 
process may require significant time. 

 If you selected a third-party virtual machine, Parallels Transporter will launch to guide 
you through the steps of converting this virtual machine to the Parallels Desktop 6 
format. For detailed information, see Parallels Transporter User's Guide. 

4 If you added a virtual machine created in the previous version of Parallels Desktop or a 
third-party application (VMware Fusion, Microsoft Virtual PC, or VirtualBox) you will need 
to install Parallels Tools in that previous version (p. 25). 

Additionally, to add a Parallels virtual machine to Parallels Desktop 6, you can simply locate its 
.pvm bundle or .pvs configuration file and drag it to the Parallels Virtual Machines list (p. 27). 

If your copy of Parallels Desktop is not activated, you will be prompted to activate it when the 
virtual machine is added to Parallels Desktop 6. For more information about the activation see 
Activating Parallels Desktop. 
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Installing and Updating Parallels 
Tools 

To install or update Parallels Tools: 

1 Start the virtual machine and log in to the guest operating system. 

2 Choose Install Parallels Tools (or Update Parallels Tools) from the Virtual Machine menu. 

Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools can be 
installed in your guest operating system. To see the list of guest OSs supported by Parallels 
Tools refer to the Parallels Tools Overview section in Parallels Desktop Help available 
through the Help menu. 

3 The Parallels Tools installation wizard will open. 

4 In the Welcome window click Install. The wizard will start the automatic installation. 

5 When the installation is complete click Reboot to exit the wizard and restart the virtual 
machine. 

For more detailed procedures on installing Parallels Tools refer to the Parallels Desktop Help 
available from the Help menu. 
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This chapter outlines the major day-to-day operations that you are likely to perform on your 
Parallels virtual machines. 

In This Chapter 
Parallels Virtual Machines List ............................................................................................. 27 
Performing Main Operations on the Virtual Machine........................................................... 30 
Configuring the Virtual Machine .......................................................................................... 33 
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Parallels Virtual Machines List 
The Parallels Virtual Machines list shows the virtual machines and virtual machines templates 
currently registered in Parallels Desktop. 

Note: If you have no virtual machines and no virtual machines templates registered in Parallels 
Desktop, the Parallels Virtual Machines list will not open. 

To open the Parallels Virtual Machines list do one of the following: 

 Choose Virtual Machines List from the Window menu. 
 Right-click the Parallels Desktop icon in the Dock and choose Virtual Machines List from the 

shortcut menu. 
 Start Parallels Desktop and close the Welcome window (p. 16). If you have at least one 

registered virtual machine or virtual machine template, the Parallels Virtual Machines list will 
appear. 

 Start Parallels Desktop with the Welcome window disabled. Provided that you have at least 
one registered virtual machine or virtual machine template the Parallels Virtual Machines list 
will appear. 

Note: To disable the Welcome window (p. 16), deselect the Show at startup option in this 
window. 
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The Parallels Virtual Machines list allows you to manage the registered Parallels virtual machines 
as follows: 

 Open virtual machines: Click the virtual machine name in the list to open the virtual machine 
window. 

 Start virtual machines: Click the Start button  or right-click a virtual machine and 
choose Start from the shortcut menu. 

 Edit the virtual machine configuration: Right-click a virtual machine and select Configure 
from the shortcut menu. 

 Locate the virtual machine files on your Mac: Right-click a virtual machine and choose Show 
in Finder from the shortcut menu. 

 Rearrange the virtual machines: Drag a virtual machine to the desired position. 
 Remove any virtual machine: Drag a virtual machine from the list or right-click it and select 

Remove from the context menu. You can add it back to the list later. 
 Assign colors to your virtual machines: Right-click a virtual machine and select the desired 

color from the shortcut menu. In Finder, the virtual machine .pvm bundle will be marked 
with the same color. 

If the virtual machine files are stored on a remote USB device or network server, you will see 
the corresponding icon to the right of the virtual machine name. 

If you right-click a virtual machine template, the set of commands will differ slightly. The Start 

button  is not available because you cannot start a template, but you can choose the Convert 
to Virtual Machine or Deploy to Virtual Machine options. 

Third-party Virtual Machines 

When you start Parallels Desktop, it finds all third-party virtual machines (VMware, Microsoft 
Virtual PC, Virtual Box) stored on your Mac using the Spotlight search and adds them to the 
Parallels Virtual Machine list. Before using these machines, you need to covert them into the 
Parallels Desktop format. Open a third-party virtual machine and conversion will begin. 

If you do not want to convert a third-party virtual machine into the Parallels Desktop format, 
simply remove it from the Parallels Virtual Machines list. Parallels Desktop will not add it to the 
list any more. 

The Menu 

This menu is situated in the lower left corner of the Parallels Virtual Machines list: 
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With the help of this menu, you can: 

 Create a new virtual machine: Click the  button to start New Virtual Machine Assistant. 

You can also click the  button and select New from the menu. 

 Add an existing virtual machine to the list: Click the  button and select Open from the 
menu to add an existing virtual machine stored on your Mac, on an external USB storage, or 
on the network. 

 Import a physical computer or virtual machine: Click the  button and select Import from the 
menu to migrate a physical or virtual computer (VMware, Microsoft Virtual PC, or 
VirtualBox) to a Parallels virtual machine on your Mac with the help of Parallels 
Transporter. 

 Download a virtual appliance: Click the  button and select Download from website from the 
menu. The Parallels Virtual Appliances Directory (http://ptn.parallels.com/en/ptn/dir) page 
will open. Choose a virtual appliance and download it. 

 Download the Google Chrome virtual appliance: Click the  button and select Download 
Chrome OS from the menu. Parallels Desktop will download the Google Chrome operating 
system from the Internet and add a virtual machine with installed Chrome OS to the Parallels 
Virtual Machines list. To log in to Chrome OS your computer should be connected to the 
Internet and you should provide your Google account name and password. 

 

http://ptn.parallels.com/en/ptn/dir
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Performing Main Operations on the 
Virtual Machine 

Changing the Virtual Machine State 

You can start, shut down, suspend, or otherwise manage the virtual machine state using the 
Virtual Machine State menu  in the status bar. Click the Virtual Machine State button 

 and select the desired command from the menu: 
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You can also use the Parallels Virtual Machines list (p. 27) and the Virtual Machine menu controls 
to start, stop, pause, suspend, resume, reset, or shut down the virtual machine. 

Switching the Virtual Machine View Modes 

While running a virtual machine you can switch between the following view modes: 

 Window mode. In this mode the virtual machine screen is displayed as a separate window. 
This is the default view mode. 

 Full Screen mode. In this mode the virtual machine screen is expanded to occupy the whole 
of your physical computer's screen. 

 Coherence mode. In this mode the virtual machine desktop is invisible so that you can see 
the virtual machine applications windows in Mac OS X and work with them side by side 
with your Mac OS X applications. 

 Modality mode. In this mode you can view the virtual machine and the programs running 
inside it in a transparent scaled window while working in Mac OS X. By default this 
window appears on top of all opened windows, so you can supervise your virtual machine 
during your work in Mac OS X. 

To change view modes use the View Mode menu in the lower right corner of the virtual 
machine window. 
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Note: You can change the virtual machine view mode only when the virtual machine is running. 

Installing Windows Applications 

You can install your favorite Windows applications inside a running virtual machine using the 
following media: 

 CD and DVD discs 
 Images of CD or DVD discs made with the help of third-party imaging products 

Note: Parallels Desktop supports the ISO and DMG image files and may support the CUE and 
CCD image files. 

To use a real CD/DVD disc: 

1 Insert the disc into your Mac's CD/DVD drive. 

2 Do one of the following: 

 Click the CD/DVD icon in the virtual machine status bar and choose Real CD/DVD from 
the shortcut menu. 

 Choose CD/DVD 1 > Real CD/DVD from the Devices menu. 

To use an image of a disc: 

1 Do one of the following: 

 Click the CD/DVD icon in the virtual machine status bar and choose Connect Image 
from the shortcut menu. 

 Choose CD/DVD 1 > Connect Image from the Devices menu. 

2 Specify the image file. 

For further installation steps you should refer to the documentation of the application you are 
installing. 

Making virtual machine snapshots 

You can create a snapshot when the virtual machine is running, paused, or stopped. To make a 
snapshot: 

1 Choose Take Snapshot from the Virtual Machine menu. 

2 In the Snapshot Parameters window type a name for the snapshot in the Snapshot Name field 
and provide a short description, if necessary. 
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3 Click OK. 

To access the created snapshot open Virtual Machine Snapshots by choosing Manage Snapshots 
from the Virtual Machine menu or clicking the Manage Snapshots icon in the toolbar of the 
virtual machine main window. 
 

Configuring the Virtual Machine 
The configuration of an existing virtual machine can be changed in the Virtual Machine 
Configuration dialog. You can open this dialog by doing one of the following: 

 Choose Configure from the Virtual Machine menu. 
 In the Parallels Virtual Machines list (p. 27), right-click the virtual machine and choose 

Configure. 
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Virtual Machine Configuration allows you to configure your virtual machine in a variety of 
ways. For example, you can 

 Configure the virtual machine general options in the General window. 
 Define the virtual machine boot options in the Boot Order pane of the Hardware window. 
 Configure different parameters of the devices currently available inside the virtual machine: 

hard disk drives, CD/DVD-ROM drives, floppy disk drives, etc. 
 Configure the resource values currently set for the virtual machine: main memory, video 

memory, CPU, etc. 
 Add a new device to the virtual machine or remove an existing one. 

Detailed information on all of the settings you can configure in the Virtual Machine Configuration 
dialog can be found in the Parallels Desktop User's Guide. 
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